Unit 4:
Formatting with Cascading Style Sheets

Unit Objectives
After completing this unit, you should be able to:


Format text in your web pages.



Understand the benefits and limitations of CSS.



Create and apply class, tag and advanced style rules.



Export styles into an external style sheet.



Create and attach style sheets to your web pages.



Create style sheets for different media



Formatting Text



Introducing Cascading Style Sheets



Creating Styles



Exporting CSS Rule Definitions



Creating Class Styles



Attaching External Style Sheets



Creating Advanced Styles



Creating a New External Style Sheet



Displaying Styles



Understanding Cascading Order and Inheritance of Styles



Creating Internal Styles with the Property Inspector

Unit Topics
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Formatting Text
Dreamweaver enables you to easily change the font, size, color and other
attributes of the text on your page. Making these changes to the text
emphasizes important content, allows users to quickly scan a page to find
the information they need, and makes the page more attractive.

Web Considerations
Consider the following:


Users should be free to change the browser window size or to change
the font size and color of the text.



There is a significant difference between how font sizes are displayed
in Windows and on other operating systems and handheld devices.

Published content, whether printed, viewed through a PC web browser, or
loaded into a handheld device, should display a consistent style on each
page. Text support on the web is still very primitive as compared to a
printed document. However, you can achieve substantially more control
over the formatting of your web pages using Cascading Style Sheets.

Block vs. Character Formatting
You can apply changes to the default display of text on your web page –
either to an entire block of content or to individual characters and words. A
block is a group of content, such as a paragraph or list.
There are certain formatting options, such as text alignment, that must
work on an entire block.
With character formatting you can apply a different font treatment to
individual letters or words, such as bolding or changing the font.
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Introducing Cascading Style Sheets
The Cascading Style Sheets (CSS) specification for HTML pages allows
you to define the way the content on your page is displayed. CSS provides
more flexibility and control of the appearance of your page than straight
HTML, controlling colors, typography, and the size and placement of
elements and images on your pages.
The advantage of using style sheets is that changing an attribute of a style
results in instant reformatting of all the text controlled by that style. Style
sheets can also be used to affect positioning of objects and images.

CSS Terms


A style rule, which is a group of formatting properties identified by a
single name, controls the formatting of text. This includes the font, the
text size, the text color, and the line spacing, among other options.



A style sheet is a group of styles that define the way your web pages
look.

A CSS formatting rule consists of two parts — the selector and the
declaration. The selector is a term (such as P, H1, a class name, or an id)
that identifies the formatted element, and the declaration defines what the
style elements are. For example, if you define a style rule for the p tag and
set the font property to Helvetica, the selector is the p tag and Helvetica is
the declaration.

CSS Style Definition Locations
There are three ways you can define styles:


Using a separate style sheet, an external style sheet, that is easily
attached to your pages



Embedding styles directly into pages – an internal style sheet



Applying a style directly to a piece of text – an inline style

There is rarely any reason to use inline styles, and they are not generally
recommended as they can make the formatting of your web site more
difficult to maintain. Therefore, this course will cover only external and
internal style sheets.

2008 Fig Leaf Software, Inc. Portions ©2005 Adobe Systems.

4-3

Adobe Dreamweaver CS4: Website Development

CSS Benefits
Benefits of CSS include:


Keeps the look consistent on all the pages throughout the site or
section.



Allows you to format paragraphs and text in ways you cannot using
HTML.



Keeps display and content structure separate, thereby making it easier
to update the site.



Makes it easier to reuse the content in a different context, by simply
providing an alternate style sheet.



Makes it easier to maintain the site by keeping all formatting
specifications in a single CSS file.



Creates smaller pages, thus decreasing page load times.



Meets the standards for XHTML.

Limitations
Browsers' rendering of content when using Style Sheets for typography is
consistent across most desktop and mobile browsers. The consistent
formatting of content when using CSS for positioning (covered in unit 6)
remains problematic across multiple browsers. Test your pages rigorously
across multiple browsers, versions, and operating systems to ensure a
consistent experience for your users.
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Creating Styles
You use the CSS Styles Panel to create, view, edit, move, or remove CSS
within or attached to your document. You can see the properties affecting
the currently selected text if you are in Current mode, or you see all the
rules and properties that affect the entire document if you are in All mode.
To switch from one mode to the other, you click either All or Current on
the CSS Styles panel.
When you are in All mode, the CSS Styles panel displays two panes: the
All Rules pane at the top and the Properties pane at the bottom. The
Properties pane lets you edit or add new CSS properties in the All Rules
pane for the selected style rule. Any changes you make in the Properties
pane are immediately applied to your document.
You can create a new style rule for a document in several ways:


Choose Format CSS Styles  New.



Choose Window  CSS Styles to open the CSS Styles panel.
Click New CSS Rule on the panel.



Choose New from the Options menu.

CSS Styles panel
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CSS Rule Types
You can create a new CSS rule to control the formatting of an HTML tag
or a range of text. If you want to control all the text within a tag, you define
a tag rule. If you want to control a range of text, then you define a class
rule.
The New CSS Rule dialog box allows you to create three types of CSS
rules:


Class when you want to define a style and apply it to any selected text.



Tag when you want to redefine the way text inside an HTML tag
displays.



ID when you want to define a style that applies to a specifically named
element on a page



Compound when you want to define the formatting for a particular
combination of tags or for contextual selectors.

Creating a class rule
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Embedded Style Sheet
When you create a style rule, you have the option to save the rule as an
embedded rule within your page, or save it to an external file. Selecting
This Document Only within the Define In section of the New CSS Rule
dialog box saves your rule within the document. Choosing this option
means that only the current document has access to the style rule. If you
want your pages to reflect all the same styles, you would create an external
style sheet, which is covered later in this unit. If a page should look
different from other pages in your site, define the rules for that page as
embedded styles.
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HTML Tag Rules
Tag rules allow you to format any HTML tag in a consistent way. For
example, you can create a tag style definition for a heading 2 tag and that
formatting is automatically applied to all heading 2 text in the document.

New CSS Rule for H2
Choose Tag as the Selector Type. Choose a tag from the Tag pop-up menu
or type the name of the tag in the text box. Select This Document Only to
make it an embedded style.
Once you click OK, the CSS Rule Definition dialog box opens. You can
set the formatting options for the style rule.
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New CSS Rule Definition
In the CSS Rule Definition dialog box, you can set various formatting
options. For example, you use the Type category to define basic font and
type settings for a CSS style.

Tag rule definition dialog box
The CSS Rule Definition dialog box displays a variety of options based on
the category selection. A brief description of the options in each category is
listed below.
Category

Description

Type

Font attributes such as font type, size and color.

Background

Background color or image and other background
properties.

Block

Text alignment and indentation, along with other text
block properties.

Box

Margins and padding around the text or image.

Border

Set a border around text. Note the following:


For borders to appear, you must set the size, color,
width, and style for each side of the border that
should be visible.



If you want borders only on some sides, you must
explicitly set the width to zero for sides that should
not have a border.
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Category

Description

List

Change the bullet and position of the bullet. List
properties are usually applied to list and list item
elements only.

Positioning

Set the exact placement of the text within the page.
Positioning is supported most widely for layers and is
usually used with them.

Extensions



Page break forces a page break during printing
either before or after the object controlled by the
style. This option is not supported by any 4.0
browser.



Cursor changes the pointer image when the pointer
is over the object controlled by the style. Doesn’t
work in all browsers.



Filter applies special effects to the object controlled
by the style, including blur and inversion. Choose
an effect from the pop-up menu. Only Internet
Explorer supports this attribute.
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Setting CSS Preferences
There are several options you can control when working with CSS. You
can specify that Dreamweaver use a shorthand form that may be easier to
work with. However, some browsers may not recognize this form, so this
option will not be covered in this class.
You can also control the action taken when you double-click in the CSS
Styles panel. Choose Edit  Preferences (Windows) or Dreamweaver 
Preferences (Macintosh) to open the Preferences dialog box and select CSS
Styles in the Category list. Your options are:


Edit using CSS dialog



Edit using Properties pane



Edit using Code view

CSS Styles preferences

Editing Style Rules
Once you create a style sheet, you can easily add or change styles. When
you edit a style sheet that controls the text in a document or in your site,
you instantly reformat all the text controlled by that style sheet.
Once you add a style rule, you can edit it using the CSS Styles panel. If
you are in the All Rules mode do one of the following:


Double-click the selected rule in the All Rules pane to open the CSS
Rule Definition dialog box and then make your changes (if this option
is selected in the CSS Rule preferences.)
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Select a rule in the All Rules pane and then edit the rule’s properties
using the Properties pane below.



Select a rule in the All Rules pane and then click Edit Rule

.

Now you can change the style as desired in the CSS Rule Definition
dialog box.
You can also use the Properties pane of the CSS Styles panel to edit
your styles.


Click the Show Only Set Properties button on the CSS Styles panel
to view only the properties defined for the selected rule.



Select the property you want to edit in the Properties pane and then
change the value.

Properties pane options
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When you select the property value in the Properties pane, you can enter
new values for the property or choose a value from a pop-up menu if one
exists for that property. For example, for the font-size property, a pop-up
menu with various preset sizes appears when you select that value.

Font size value pop-up menu
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Using Points, Pixels or Ems for Font sizes
When you modify the font-size property, you’ll notice that there are several
measurement options you can use for the font-size.
Relative sizes


xx-small – xx-large: defines fonts relative to the browser font size



percentages: relative to the surrounding text



ems and exs: relative to the parent element, the term "ems" refers to the
size of the capital letter "M"



pixels: relative to the screen resolution

Absolute Sizes


Points and picas – print units



Inches, centimeters and millimeters – length units

Points are units for printing and should be used only in style sheets for
print. Pixels are units based on the resolution of the screen. If you want
absolute control over the look of your text on the screen, you may want to
use pixels. The downside of using pixels is your users may not be able to
adjust the font size in older browsers, leading to accessibility problems.
If accessibility is an important goal in building your web pages, then you
should use ems. Ems are sized so that the font size is relative to the parent
element. In the case of most Web pages, this is the body element, thus the
font is sized relative to the standard size of the browser.
Using ems as your font size measurement ensures that your pages will be
accessible to most browsers and platforms. Plus, if your readers choose to
change the default font size on the fly, your page will scale to that new
size.
The problem with ems is that you lose control over the exact look of your
page. Some people may have a much larger or smaller default size than you
are used to, and with ems, your fonts will scale relative to that size.
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Walkthrough 4-1.: Formatting Text with CSS
In this walkthrough, you will perform the following tasks:


Create a new page and apply HTML tags.



Define a new embedded style rule.



Edit the style rule with the CSS Styles panel.



Duplicate a style rule and change its properties.

Steps
1. Create a new page and name it info.htm.
2. Title your page Cafe Townsend Information.
3. Open text/info.txt, select all the text, copy it, and then paste the text
into the info.htm page.
Format Headings

4. Select “Restaurant Information” and format as Heading 1.
5. Select “Awards and Recognition” and format as Heading 2.
6. Select “Cafe Townsend is Proud to Offer…” and format as Heading 2.
7. Select “Contact Us” and format as Heading 3.
8. Click within various other lines on the page and look at the tag selector
or Property inspector to verify they are all paragraph or <p> tags.
Define a new embedded style rule

9. Choose Window  CSS Styles to open the CSS Styles panel if it is
not already open.
10. Click New CSS Rule on the panel to define a new rule, set these
options, and then click OK:


Selector Type: Tag



Tag: p (for paragraph)



Define In: This Document Only

11. In the Type category of the CSS Rule Definition dialog box choose the
following and then click OK:


Font: Georgia, Times New Roman, Times, serif



Size: 12 points

12. Click Show Only Set Properties on the CSS Styles panel to view the
properties you just defined for your style rule.
13. In the Properties pane, change the font-size to .95 ems.
2008 Fig Leaf Software, Inc. Portions ©2005 Adobe Systems.
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14. Click Edit Style on the CSS Styles panel. Use the color picker to
change the text color to a dark gray (#333333) and then click OK.
Note: When you use the color picker, Dreamweaver adds the # sign
before the hex color. If you type the hex value, make sure you add the
# sign before the hex values. Dreamweaver displays the color correctly
without it, but browsers may not.
15. Click Add Property on the CSS Styles panel and choose line-height
from the pop-up menu on the left.
16. Type 20 in the text box and choose pixels from the pop-up menu on
the right.
Format the heading tags

17. Click within the top line formatted as a Heading 1. Click New CSS
Rule on the CSS Styles panel, set the following options, and then click
OK:


Selector Type: Tag



Tag: h1 (for heading 1)



Define In: This Document Only

18. In the Type category of the CSS Rule Definition dialog box choose the
following and then click OK:


Font: Georgia, Times New Roman, Times, serif



Size: 1.4 ems



Color: dark blue (#000033)

19. Verify that All Mode is selected in the CSS Styles panel. Select h1
from the list and then choose Duplicate from the CSS Styles panel
Options menu.
20. Change Tag to h2 and then click OK.
21. Select h2 in the All Rules pane and change font-size to 1.2 ems in the
Properties pane. Press Enter (Windows) or Return (Macintosh).
22. Repeat steps 19–20, changing the Tag to h3 and the font-size to
1.1 ems.
23. Save your file and then preview in the browser.
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Exporting CSS Rule Definitions
Thus far, all style rules that you’ve created have been embedded into
HTML pages. The benefits of using CSS are far greater when you store all
your style rules in an external style sheet (a file with a .css extension). You
can then link this file to some or all of the pages in your site.
If you already have styles defined within a page, Dreamweaver lets you
export your styles to an external style sheet.
You can export style definitions from an open page using one of these
methods:


Right-click (Windows) or Control-click (Macintosh) on the style in the
CSS Styles panel and choose Move CSS Rules…



Drag and drop a style in the CSS Styles panel from the <style> block
into a linked CSS file.

Moving Rules from the CSS Styles panel
You will be prompted to either select a previously linked style sheet or
choose a location and file name for a new .css file that will be created.
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Creating Class Styles
Class styles are the only type of CSS styles that can be applied to any text
within a document, even if tag rules also control the text. For example, if
you create a tag rule for heading 3 text, you can also select a word within
the text and apply a class style. The class style formatting then overrides
the tag style for the selected word.

Add a new class style
Create a new style rule by choosing Text  CSS Styles  New or by
clicking New Style Rule in the CSS Styles panel.


Select Class in the Selector Type



Type the class name in the Name text box



Select to save the class style rule as embedded or in an external style
sheet

New CSS Class rule
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Naming Class Styles
When you create a class style you need to supply a name for the style. For
example, if your class style is meant to call attention to the name of your
company, you can name your style.companyname to identify it for use
throughout your site.
As a general rule, it is best to name your classes according to their purpose
rather than their appearance. Appearance can change over time, while the
purpose of the class usually stays the same.
Class styles names need to start with a period. If you forget the period
before the name, Dreamweaver adds it for you.
To rename the class style:
1. Select the style in the CSS Styles Panel.
2. Do one of the following:


Right-click (Windows) or Control-click (Macintosh) and choose
Rename Class from the context menu.



Choose Rename Class from the CSS Styles panel Option menu.



Click on the Class in the CSS Styles panel and press F2 on your
keyboard

3. Type a new name in the Rename Class dialog box and then click OK.

Rename a style rule
2008 Fig Leaf Software, Inc. Portions ©2005 Adobe Systems.
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Applying the Style
The difference between a class style and a tag style is that you do not
manually apply tag styles to text with tag styles. Once you create a tag
rule, all the tagged text is formatted the same. For class styles, you need to
select the text or range of text you want with the style and then apply the
style.
To apply the style:


Select the text where you want to apply the CSS style. You can
position the insertion point within a paragraph to apply the style to the
entire paragraph or select a range of text.



Do one of the following:


Choose the style you want to apply from the targeted rule pop-up
menu in the Property inspector.



Select the text in the Document window and then right-click
(Windows) or Control-click (Macintosh) and choose CSS Styles 
[style name] from the context menu.

Apply Class style from Property inspector

Removing Class Styles
To remove a class style from your text, select the text which has the style
applied and then choose from one of the following:
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Choose Remove Class from the Style pop-up menu in the Property
inspector.



Select the text in the Document window and then right-click
(Windows) or Control-click (Macintosh) and choose CSS Styles 
None from the context menu.
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Attaching External Style Sheets
Style sheets are files with .css extensions that contain only style rules.
These files can be created with Dreamweaver, or you can type the style
rules in a text editor. You can attach one or more style sheets to a page.
The style rules, except for class styles, are applied automatically to that
document. You will need to manually apply any class styles to paragraphs
or selected text.
The advantage to using external style sheets is that changing a style
definition in the external style sheet updates all the pages linked to that
style sheet. You can see a wonderful demonstration of this by viewing the
CSS Zen Garden website at http://www.csszengarden.com
To attach to an existing style sheet, open the desired page and then click
Attach Style Sheet at the bottom of the CSS Styles panel.

Attach Style Sheet button
You can also attach a style sheet from the Format menu on the
Dreamweaver CS4 menubar. Select Format > CSS Styles > Attach Style
Sheet.
Note that Dreamweaver CS4 contains a number of sample style sheets that
you may be able to leverage for your site.
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In the Attach External Style Sheet dialog box, click Browse and then locate
the style sheet you want to attach. Click OK to attach the file.

Attach External Style Sheet dialog box

Media Type
The Media type specifies how the document is to be presented on different
media. For example, you can create a style sheet that defines the way your
page looks when printed or displayed on handheld devices. Select the
Media type from the Media pop-up menu. Your options for Media are:


All – suitable for all devices



Aural – speech



Braille – for Braille tactile feedback devices



Handheld – PDA, small screen, limited bandwidth



Print – for printed material



Projection – for projector devices



Screen – for computer screens



TTY – teletype, terminals, or portable devices with limited display
capabilities



TV – television type devices

Media type pop-up menu
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Once a style sheet is attached, you will see the file listed in the CSS Styles
panel. Click the plus sign (Windows) or the triangle (Macintosh) to the left
of the style sheet name in the All Rules pane to view the rules defined for
the style sheet.

Attached style sheet

Link vs. Import
To create a link between the current document and an external style sheet,
select Link in the Attach External Style Sheet dialog box. This creates a
link tag in the HTML code, and references the URL where the published
style sheet is located. This method is supported by both Microsoft Internet
Explorer and Firefox.
You cannot use a link tag to add a reference from one external style sheet
to another. If you want to nest style sheets, you must use import. Some but
not all browsers also recognize the import directive within a page (rather
than just within style sheets). There are subtle differences in how
conflicting properties are resolved when overlapping rules exist within
external style sheets that are linked versus imported to a page. If you want
to import, rather than link to, an external style sheet, select Import when
you attach the external style sheet.
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Walkthrough 4-2.: Export and Add a Class Rule
In this walkthrough, you will perform the following tasks:


Export CSS as an external style sheet.



Create a new class rule.



Apply the class rule to selected text.

Steps
1. Return to info.htm.
Create a Class rule in a new Style Sheet

2. In the CSS Styles panel, click New CSS Rule. In the New CSS Rule
dialog box set the following options and then click OK:


Selector Type: Class



Name: boldit



Rule Definition: (New Style Sheet File)

3. In the Save Style Sheet File As dialog box, click on the Site Root
button
4. Enter a file name of cafe.css and click Save.
5. In the Type category of the CSS Rule Definition dialog box choose:


Font: Arial, Helvetica, sans-serif



Size: .95 ems



Weight: bold



Color: dark red (#990000)

6. Select the Block category and type .1 in the Letter Spacing text box
and choose ems from the units pop-up menu. Click OK.
Export CSS to an External Style Sheet

7. In the CSS Styles panel, right click on all the styles that are registered
in the page and select Move CSS Rules…
8. Confirm that the radio button for Style Sheet is selected and that
choose cafe.css from the drop-down menu. Click OK.
9. Select <style> in the All Rules pane of the CSS Styles panel and then
click Delete Embedded Stylesheet on the CSS Styles panel.
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Delete and link to a Style Sheet

10. Right-click on cafe.css in the Styles panel and select Delete
11. Click on the Attach Stylesheet button in the CSS Styles Panel.
12. Browse for the file /cafe.css
13. Select Link as the Add As option, select Screen in the Media pop-up
menu and then click OK.
Apply the class rule

14. Select the text “TYPE OF CUISINE.” Choose boldit from the Style
pop-up menu in the Property inspector.
15. Select the next text that is in uppercase and then choose Edit  Redo
Apply.
16. Repeat step 10 for the remaining uppercase text.
Note: The shortcut for Redo Apply is Ctrl+Y (Windows) or Cmd+Y
(Macintosh). Double-clicking a word selects the word.
17. Save the file and preview it in the browser. Leave the file open for the
next walkthrough.
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Creating Advanced Styles
Advanced styles are used for controlling tags in the following ways:


Specify the style for part of a block of text, such as the first letter of a
paragraph.



Specify the style for text in a certain state, such as a hyperlink that has
been visited.



Change the display of text controlled by a combination of tags.

Selectors
When you create a new style and select Advanced as the selector type, you
are required to enter a selector. The selector can be any one of the
following:


Pseudo-element selectors, for redefining the first letter or the first line
of a block of text.



Combination selectors:


Contextual selectors, used for a rule that applies to a tag only
when it is nested within another specific tag.



Group selectors, where a group of tags have the same style rule.



Pseudo-class selectors, for redefining the way links are displayed as a
user selects them.



ID selectors, where the ID matches the id value of an element (#title),
which can only be applied to one element on a page (id attributes are
generally used to identify a particular element for scripting purposes or
to specify the location of images).

Pseudo-class selectors will be covered in Unit 6: Navigating Your Site.
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Using Pseudo-Element Selectors
You can create first-line and first-letter pseudo-element selectors by typing
appropriate tag information in the CSS Selector text box:
Selector

Description

Example

{tagname}:first-line

Controls the formatting of the first
line of text for the specified tag.

p:first-line

{tagname}:first-letter

Controls the formatting of the first
letter of text for the specified tag

p:first-letter

Note: First-line and first-letter pseudo-classes are not as widely supported
as link pseudo-classes and should be used with care. Microsoft Internet
Explorer 5.5+, Netscape 6+, Firefox 2+, and Opera 6+ all support these
pseudo-classes, but with some variations in rendering.

Combination Selectors
There are two types of combination selectors that you can create by typing
the selector name into the CSS Selector text box:
Selector
Type

Description

Example

Contextual

Specifies a style rule that is
applied to a tag only when it
appears in the context of (nested
within) another specific tag. There
should be a space between these
tags.

In this example, the style rule is
applied only to text within a
<strong> tag inside a <p> tag that
is inside a <td> tag:
td p strong

Group

Specifies a single style rule that
will apply to a group of tags. A
comma should separate each tag.

In this example, the style rule is
applied to the paragraph tag, the
table data tag (<td>) and the list
item tag (<li>):
p,td,li

Note: You should use group selectors only when multiple tags require
exactly the same style.
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Walkthrough 4-3.: Creating an Advanced Style
In this walkthrough, you will perform the following tasks:


Apply bold and italic formatting to some text.



Create an advanced selector to format text with nested tags.

Steps
1. Return to the info.htm file.
Add an Advanced Selector

2. Select “Restaurant News” beneath the Awards and Recognition
heading; click I (italic), and then click B (bold) in the Property
inspector.
Note: the order in which you apply italic and bold is important. If you
click B first and then I, you would need to type “em strong” for step 4.
Place your insertion point within the text and look at the tag selector to
see the order you applied the tags.
3. Repeat step 2 for “California Magazine.”
4. Click New CSS Rule in the CSS Styles panel and set the following
options in the New CSS Rule dialog box and then click OK:


Selector Type: Advanced



Selector: strong em



Define In: cafe.css

5. Change the font color to a dark green color (#336666) and the font size
to .9 ems and then click OK.
6. Save your file and preview in the browser.
7. Leave your file open for the next walkthrough.
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Creating a New External Style Sheet
You can create an external style sheet from scratch using Dreamweaver,
rather than exporting internal styles.

Creating an External Style Sheet
To create an external style sheet:
1. Choose File  New.
2. Select the Blank Page category and then select CSS from the Page
Type list. Click Create. Dreamweaver creates a new document in
Code View.
3. Choose File  Save and save your file.
Note: Dreamweaver automatically adds the .css extension to your file
name. It is required for the style sheet to work properly.
4. Click New CSS Rule on the CSS Styles panel to add rules to your
style sheet.

New CSS Document
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Displaying Styles
As a default, Dreamweaver displays your page for the screen media type,
which shows how the page is displayed on a computer screen. If you add
an additional media type style sheet, you can preview both styles within
Dreamweaver. When you attach a style sheet and choose a media type
from the Media pop-up menu, you are creating a media-dependent style
sheet.
The Media type needs to appear on all attached style sheets within a page
to render the styles properly in Dreamweaver.

Media Type in Attach External Style Sheet
After you attach your media-dependent style sheets, verify that the Display
Styles option is selected. Choose View  Style Rendering  Display
Styles to select the option if it is not already selected. A check mark before
the menu option indicates the option is already selected.

Display Styles rendering option
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The Style Rendering Toolbar
The Style Rendering Toolbar contains buttons you can use to view your
page using different media types. If your page doesn’t contain mediadependent style sheets, then the toolbar buttons are disabled. The toolbar
also contains a button you can use to enable or disable CSS styles in your
document, which is the same as choosing Display Styles from the Style
Rendering menu item in the View menu.
To access the Style Rendering Toolbar do one of the following:


Choose View  Toolbars  Style Rendering



Right-click (Windows) or Control-click (Macintosh) on the Document
or Insert toolbars and choose Style Rendering from the context menu.

Style Rendering toolbar
Click the various Rendering buttons on the toolbar to view the page using
different media types.

Style Rendering buttons on toolbar
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Walkthrough 4-4.: Creating an External Style
Sheet
In this walkthrough, you will perform the following tasks:


Create an external style sheet.



Add several style rules to the external style sheet.



Attach the style sheet for print media.



View the page with different styles.

Steps
Create a new style sheet

1. Choose File  New.
2. Select the Blank Page category and then select CSS from the Page
Type list. Click Create. Dreamweaver creates a new document in
Code View.
3. Choose File  Save and save your file as cafe_print.css in the
root folder.
4. Click New CSS Rule in the CSS Styles panel.
5. In the New CSS Rule Definition dialog box:


Selector Type: Tag



Tag: p



Define In: This Document Only



Click OK.

Note: Because the external style sheet is open, you are adding a rule to
the external style sheet, even though you selected This Document Only.
6. In the CSS Rule Definition dialog box, set type properties as follows
and then click OK:


Font: Times New Roman, Times, serif



Size: 12 points



Line height: 16 points

7. Save your CSS file and return to the info.htm file.
8. Click Attach Style Sheet on the CSS Styles panel.
9. Click Browse then locate and select the cafe_print.css file you just
created. Click OK (Windows) or Choose (Macintosh).
10. Select Print as the Media type and then click OK.
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Render your styles

11. If the Style Rendering toolbar is not visible, right-click (Windows) or
Control-click (Macintosh) on the Document or Insert toolbar and
choose Style Rendering from the context menu.
12. Verify that style rendering is on by checking that the last icon (Toggle
Displaying of CSS Styles) is selected. If not, select it.
13. Click Render Print Media Type on the Style Rendering toolbar and
view the changes in the text.
14. Select cafe_print.css in the CSS Styles panel and then click New CSS
Rule and create a new rule for heading 1 using the following
properties and then click OK:


Font: Arial, Helvetica, sans serif



Size: 20 points



Weight: bold

15. Duplicate the h1 style rule and change the tag to h2. Change the font
size to 16 points.
16. Repeat step 15 change the style rule to h3 and the point size to 14.
17. Click Render Screen Media Type from the Style Rendering toolbar to
return your page to the screen type definitions.
18. Save and preview your page in the browser.
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Understanding Cascading Order and
Inheritance of Styles
CSS rules can be applied to page content in three ways:


Linking a separate .css file to the page — an external style



Embedding a style sheet within the page — an internal style



Applying an inline style to text on the page

The cascading order of styles determines what style appears on your page
when you have multiple style rules applied.
If you have an external style sheet linked to your document, those styles
are applied across your document. If there is more than one style applied to
the same tag, there is an order in which the styles are applied.
The order of precedence (most-least) is:


Inline style



Internal style



External style

Note: As mentioned earlier, inline styles are rarely needed and are not
covered in this course.

Example
Suppose that in an external style sheet linked to a page, you have the
following rule for paragraphs:
p {font-family: sans-serif;
color: blue}

In the same page you have an embedded style sheet with its own rule for
paragraphs:
p {font-size: 14pt;
color: green}

A paragraph in the page would have following style:
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Sans-serif font (specified in the external style sheet)



14 point font-size (specified in the embedded style sheet)



The color green (the value specified in the embedded style sheet takes
precedence over the value in the external style sheet)
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Inheritance Example
Suppose that you have defined the following styles:
p {color: green;
font-weight: normal;
font-family: Arial}
em {font-weight: bold;
color: blue}
.code-red {color: red;
text-decoration: overline}

Assume that you have the following text and HTML code in your page:
<p>In case of emergency, <em class=”codered”>walk</em> to the nearest exit.</p>

The word “walk” will be in Arial font (assuming that the client computer
has that font installed), bold and italicized, have the color red, and a line
above the text.
The reason is for this result is inheritance. Because the <em> tag is nested
inside a <p> tag, it inherits the style properties of the <p>, although its own
style may add to or override those of the <p> tag. (In this case the <em>
style overrides both the color and font-weight properties, so it only inherits
the Arial font-family).
Class styles inherit from the tag style in the same way. In this case the
codeRed walk inherits the font-family property of the <p> tag, the fontweight property of the <em> tag, but overrides the color property with its
own value and also adds a font-style property.
The order of precedence with regard to inheritance is:


Class properties take precedence over tag style properties for the tag



Nested tag properties take precedence over those of the parent tag

Some properties are never inherited. You can consult the CSS Reference
that is included in Dreamweaver to see whether a specific property is
inherited or not.
Note: For the most part you will not need to worry about inheritance or the
lack of it, because the CSS specifications are particularly well thought-out
on this matter – usually what happens is exactly what you would want to
happen.
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Using the Code Navigator
Dreamweaver CS4 new Code Navigator enables you to select a piece of
text and view the hierarchy of styles that are applied to your selection by
clicking on the code navigator icon . Alt+clicking on a listed style opens
the style sheet, positioning your cursor at the location in the CSS code
containing the style definition. Using this feature can help you understand
the inheritance of styles affecting your content.

Dreamweaver CS4 Code Navigator
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Creating Internal Styles with the
Property Inspector
The Property inspector displays the current formatting attributes of the
selected text. When you select text in your document and apply text
formatting using the Property inspector, Dreamweaver creates a new style
class for you that you can place in either the document or in an external
style sheet.

Changing the Font Face
The default font for text on a page is set in the user’s browser. Changing
the font face is character formatting, which means you can change the font
for the entire page or for selected text on the page. However, the font you
choose must be installed on the user’s computer. Do not assume that all
fonts are loaded on everyone’s computer.
To change the font of selected text, choose the font from the Font pop-up
menu in the Property inspector. The pop-up menu contains a list of font
combinations.

Font properties
Fonts are resolved in the following way:


If your first font choice is not available, the browser attempts to use the
second font choice and then the third.



If none of the fonts are available on the user’s computer, the text is
displayed in the browser’s default font.

To remove a font face from text, select the text, and then choose Default
Font from the Font pop-up menu in the Property inspector.
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Creating Your Own Font Set
You can create your own font set by choosing Edit Font List from the Font
pop-up menu in the Property inspector. Generally, you want to choose two
or three fonts for your font choices.
For the last choice in your list, choose a generic font type: cursive, fantasy,
monospace, sans-serif, or serif in case a user doesn’t have any of the
specified fonts installed.

Editing the font list

Changing the Font Size
The browser determines the default size for text. You can change the font
size from the Size pop-up menu in the Property inspector.

Font size options
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Changing the Font Color
You can easily change the font color for your text. Select the text, and then
do one of the following:


Click the Text color box in the Property inspector. In the color pop-up
palette, use the eyedropper pointer to select the color you want.



Move the eyedropper pointer over a graphic or text and click to pick up
the color from that item.



Type the color code (in hexadecimal) in the Color text box.

Font color pop-up palette

You can apply bold and italicized styles in Dreamweaver to add emphasis
or contrast to text in your document.
To add bold or italic, select the text, and then click the B or I button in the
Property inspector. To remove a style, click the button again.

Bold and italic formatting buttons
Applying bold formatting surrounds the text with <strong></strong> tags,
and italicizing inserts the <em> </em> tags. You can select an option in
the General category of the Preferences dialog to use <b></b> and
<i></i> instead, respectively.
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Changing the Text Alignment
Text alignment in Dreamweaver works as it does in word processing
programs. You can align a block of text to the left (the default), center,
right, or justify it. To align text, click one of the alignment buttons in the
Property inspector.

Text alignment buttons
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Walkthrough 4-5.: Cascading Styles
In this walkthrough, you will perform the following tasks:


Add an embedded class style.



Note the results of the cascading order.

Steps
1. Return to info.htm.
Add a new internal style to test cascading order

2. Select the three address lines.
3. In the Properties panel, select <New CSS Rule> from the targeted rule
drop-down list
4. Enter a name for the selector of .address and set the rule definition to
(this document only)
5. Use the Property inspector to change the formatting as follows:


Font: Arial, Helvetica, sans-serif



Color: dark blue (#000066)



Bold

6. Click and hover on the first address line. The Code Navigator button
will appear
7. Click on the Code Navigator button. It should indicate that both the P
tag styles and the .address class are being applied to your selection
8. Click on the Current button in the CSS Styles Panel
9. Click on each style property noting where each has been defined.
10. Save the file and preview it in the browser.
Note: The formatting in the embedded style sheet overrides the formatting
in the external style sheet.
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Unit Summary
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Dreamweaver creates embedded class styles when you change
formatting in the Property inspector.



Styles are display rules that can be applied to HTML tags or selected
text.



Style sheets are groupings of rules that can be stored in a .css file.



You can create your own tag, class or advanced styles in the CSS
Styles panel.



Style sheet files can be linked to one or many files, thus applying
consistent style formatting to all HTML tags in those pages.



Linked style sheets are the most useful since they consolidate
maintenance of the display into one file.
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Unit Review
1. What are some benefits of using style sheets?

2.

What does the “cascading” mean in CSS?

3.

How do you associate a style sheet with an HTML page?

4. What types of properties can you set for a tag style?

5. What advantage does a linked style sheet have over an embedded style
sheet?

6. What is the difference between cascading order and inheritance?
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Lab 4: Creating a Site-Wide Style Sheet
In this lab, you will create an external style sheet within a document and
add several types of styles. You will attach the style sheet to a menu page.

Objectives
After completing this lab, you should be able to:


Create new style rules for HTML tags.



Attach a style sheet to an HTML document.

Lab 4 Solution
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Steps
1. Create a new page and save it as menu.htm.
2. Title the page Cafe Townsend Menu.
3. Open text/menu.txt, select all the text, copy it, and then paste it into
the menu.htm file.
4. Add the text Cafe Townsend Menu as the top line of the text and
format it as Heading 1.
5. Format the other headers: Appetizers, Entrees, and Desserts as
Heading 2.
6. Format “Friday catch of the day” as Heading 2.
7. Format the items under each heading 2 as bulleted text.
Create New Heading Tag Styles

8. Create a new external style sheet and name it menustyles.css Attach
the style sheet to menu.htm and use Screen as its media type.
9. Add the following style rules:
Tag

Rule

h1

Type:

h2

li



Font: Arial, Helvetica, sans-serif



Size: 1.5 ems



Color: (brownish red) #954A00

Type:


Font: Arial, Helvetica, sans-serif



Size: 1.2 ems



Color: (dark purple) #330066

Type:


Font: Georgia, Times New
Roman, Times, serif



Size: .9 ems



Line-height: 2 ems



Color: (dark gray) #333333
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p

Type:


Font: Georgia, Times New
Roman, Times, serif



Size: .9 ems



Line-height: 1.5 ems



Color: (dark gray) #333333

Create a class style

10. Create a new class style with the following settings:
.running

Type:


Font: Arial, Helvetica, sansserif



Weight: bold



Size: .9 ems



Color: (dark brown) #583A00

Apply class style to text

11. Select the item name (for example: Roasted Tomato Soup) in each
bulleted list and apply the .running style to the text.
Attach an external style

12. Attach the cafe_print.css style sheet and assign Print as its media
type.
13. Save the file and preview it in the browser.
14. Customize any of the styles to your liking. For example, you can
change the color, or the size of the text.
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